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v2.4 User Guide 
 

Thank you for choosing our GPS tracking solution for your fleet and asset tracking needs. Our goal is to 
help you streamline and maximize the resources you already have. 

 
As part of our continued efforts to keep you at the forefront of GPS fleet and asset tracking technology, 

we are pleased to offer this User Guide. This guide lists and describes all of the features that are available 
in your GPS Tracking system. 

 
We hope you take advantage of the information that is available at your fingertips to make your 

operations even more efficient. If you have any questions regarding any of these features, please contact 
your customer support team. 
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Map Tab 
 

These actions are available under the Map tab 
 

 
 

Changing the Map View 

1. Select the View dropdown from the upper left corner of the map 
 

 
 

2. Use the checkboxes to select the level of detail displayed on the map 
a. Show Vehicles – shows vehicles on the map 
b. Show Landmarks – shows landmarks on the map 
c. Show Route Lines – shows the route lines taken by a vehicle 
d. Snap Routes to Road – aligns the route information to existing roads 
e. Show Traffic – shows current traffic information, which may not match conditions at the 

time a route was taken 
f. Show Terrain – shows terrain information 
g. Show Weather – shows current weather information, which may not match conditions at 

the time a route was taken 
h. Use Clustering – displays vehicles in small groups that will separate when a user zooms in 
i. Show Vehicle Labels – shows vehicle label information on the map 
j. Show Landmark Labels – shows landmark label information on the map 
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k. Import KML Overlay - Opens the Import KML Overlay window 

 

 
 

i. –The required fields are marked with a * 
l. KML Overlay List - opens the KML Overlay List window 

 

 
 

i. This lists all KML overlays on the account. They can be deleted or edited using the buttons 
to the right 

ii. The checkboxes to the left of the overlay list can be used to select which overlays to 
display 

 
3. The Print button opens the Print Options window 

 

 
 

4. By default, this window contains the current map view, Vehicle Control Panel and Landmarks 
Control Panel 

5. Use the checkboxes to choose which panels to include 
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Bookmarks Dropdown 

The Bookmarks dropdown allows you to save specific map views for future access. 
 

Navigating to a Bookmark 

1. Click the Bookmarks dropdown in the upper left of the map 
 

 
 

2. Select a Bookmark from the dropdown 
 

 
 

Adding a Bookmark 

1. Navigate to the map view you would like to save 
2. Click the Bookmarks dropdown in the upper left of the map 

 

 
 

3. Select Add Bookmark to open the Add Bookmark window 
 

 
 

4. Choose a name for your Bookmark 
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5. Click Save. The bookmark will be added to your account 
 

Deleting a Bookmark 

1. Click the Bookmarks dropdown in the upper left of the map 
 

 
 

2. Select Manage Bookmarks to open the Manage Bookmarks window 
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3. Click the Delete icon ( ) next to the Bookmark you want to remove 

 

 
 

4. In the Delete Bookmark window, click Yes. The deleted bookmark will be removed from your 
account 

 

 
 

Searching for an Address 

1. Enter a street address in the Address Search field at the top left of the map 
 

 
 

2. Press Enter. The map will re-center to the address provided 
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Control Panel Overview 

1. The control panels are located to the left of the map 
2. The Vehicles control panel displays all vehicles 

a. This panel can be used to locate, edit, search for, or dispatch to a vehicle 
 

 
 

3. The Landmarks control panel displays all landmarks 
a. This panel can be used to locate, edit or search for a landmark 
 

 
 

Finding a Vehicle’s Current Location 

1. In the Vehicles control panel on the left side, click the vehicle that needs to be located 
2. The map will re-center to that vehicle’s current location 
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Viewing Vehicle History 

1. In the Vehicles control panel on the left side, double click the vehicle or click the Show history 
for [Map Label] icon ( ) to open the Vehicle History tab 

 

 
 

2. The Vehicle History tab displays the Date, Event Type, Speed, Alerts, Road Speed, City, 
Address, Driver, Location, Heading, and State for all events displayed, and refreshes the 
displayed data when the map refreshes 

3. Columns can be sorted by clicking on the header or using the arrow to the right of each column 
header 

4. Choose which columns to display using the arrow to the right of the column header 
 

 
 

5. Use the dropdown in the upper left corner to customize the number of events displayed 
a. Last 10 events 
b. Last 50 events 
c. Today 
d. Yesterday 
e. Calendar allows you to select a date 
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6. Selecting an event from the vehicle’s history will display that event on the map 
 

 
 

Locating an Address from the Map 

1. Right-clicking anywhere on the map will now provide you with the precise latitude and longitude 
coordinates and the closest address. 

 

 
 

Creating a Landmark from the Map 

1. To create a landmark from the map, right-click on map and select Add Landmark 
 

 
 

2. This opens the Add Landmark window 
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3. Fill out the required fields, marked with a * 

a. Latitude and Longitude will be automatically filled in with the coordinates that were clicked 
4. Fill out the remaining fields and assign the landmark to a Group (optional) 

 

 
 

5. Click Save 
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Editing a Vehicle 

1. In the Vehicles control panel on the left side, click the Edit [Map Label] icon ( ) to open the 
Edit Vehicle window 

 

 
 

2. The Edit Vehicle window allows revision of all vehicle information 
a. Required fields are marked with a * 

 

 
 

3. Once editing is complete, click Save 
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Reading the Miniature Dashboard 

1. There is a miniature Dashboard in the upper right corner of the map 
 

 
 

2. The green arrow ( ) shows the number of vehicles currently moving 
3. The red octagon ( ) shows the number of vehicles currently stopped 
4. The orange triangle ( ) shows the number of vehicles currently idling 
5. The blue circle ( ) shows the number of vehicles with active inputs 

6. The truck icon ( ) will resize the map to include all vehicles and will reset any selected 
miniature dashboard filters 

7. The boundary icon ( ) will resize the map to include all landmarks 
8. Clicking any icon will resize the map to all applicable vehicles or landmarks and filter the 

Vehicles control panel 
9. The Map Refresh dropdown allows you to change the map data refresh rate 
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Finding the Nearest Vehicle to a Point 

1. Right click on the map and select Nearest Vehicle 
 

 
 

2. This will add a Distance To column to the Vehicles control panel 
 

 
 

3. The Clear Nearest Vehicle button will clear the Distance To column 
 

Dispatching a Vehicle 

1. In the Vehicles control panel on the left side, click the Dispatch to [Map Label] icon ( ) next 
to the vehicle being dispatched 

 

 
 

2. This opens the Dispatch [Map Label] window 
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3. Select from the dropdown to choose whether to dispatch to an Address, a Landmark or 
Coordinates 
a. If dispatching to an address, enter the Address, City, State, Zip and Country 
b. If dispatching to a landmark, choose from the Landmark dropdown 
c. If dispatching to coordinates, enter the Latitude and Longitude 

 

 
 

4. If necessary, enter any Comments 
5. Specify the recipient’s email address 
6. Click Show Directions 

a. Review all directions for accuracy prior to dispatching the vehicle 
7. Click Send Directions 
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Dashboard Tab 
 

The actions are available under the Dashboard tab 
 

 
 

Adding Widgets to the Dashboard 

1. To add a widget graph to the Dashboard, click the New widget button in the upper right 
 

 
 

2. Select a widget to create: 
a. Distance Traveled – shows how far the selected vehicles traveled during the selected 

timeframe 
b. Hard Acceleration – shows how many Hard Acceleration events occurred for the selected 

vehicles during the selected timeframe (available as an account upgrade) 
c. Hard Braking - shows how many Hard Braking events occurred for the selected vehicles 

during the selected timeframe (available as an account upgrade) 
d. Idle - shows how many minutes each selected vehicle was idling during the selected 

timeframe 
e. Move Time - shows how many minutes each selected vehicle was moving during the 

selected timeframe 
f. Speed Limit – shows how many times each selected vehicle exceeded the posted speed 

limit during the selected timeframe (available as an account upgrade) 
g. Speed Threshold – shows how many times each selected vehicle exceeded the user-

created speed threshold during the selected timeframe 
h. Stops – shows how many times each selected vehicle stopped during the selected 

timeframe 
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3. Click Create to create the widget 
 

Editing a Widget 

1. Click the Configure button at the top right of the widget you want to edit 
 

 
 

2. This opens the Edit Preferences window 
 

  
 

3. This allows you to change the Name, Date and Vehicles shown in the widget 
a. Note: The Speed Limit and Speed Threshold widgets have an option that allows you to 

narrow the vehicles displayed by how far they were over the speed limit or threshold 
 

  
 

4. Click Save 
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Printing the Dashboard 

1. Click the Print button at the top right to print your current Dashboard view 
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Alerts Tab 
 

These actions are available under the Alerts tab 
 

 
 

Types of Alerts 

Idle Alert 
Sends an alert when the selected vehicle(s) have been idling more than a set number of minutes 
 
Input Alert 
Sends an alert when one of the customer-defined inputs is active or inactive 
 
Landmark Arrival/Departure Alert 
Sends an alert when the selected vehicle(s) enter or leave the selected landmark(s) 
 
Low Battery Alert 
Sends an alert when the selected vehicle(s) battery power is lower than 11.6 volts 
 
Maintenance Alert - Distance 
Sends an alert that the selected vehicle needs maintenance after a user-defined number of miles or 
kilometers 
 
Maintenance Alert – Engine Hours 
Sends an alert that the selected vehicle needs maintenance after a user-defined number of engine 
operating hours 
 
Maintenance Alert – Time Period 
Sends an alert that the selected vehicle needs maintenance after a user-defined calendar schedule 
 
Odd Hours Alert 
Sends an alert if the selected vehicle(s) record an event outside of normal operating hours. Odd hours 
are set by the user 
 
Power Reconnect Alert 
Sends an alert when the selected device(s) power on after having completely lost power for a period of 
time 
 
Speed Threshold Alert 
Sends an alert if the selected vehicle(s) exceeds a user-set maximum speed threshold 
 
Stop Alert 
Sends an alert when the selected vehicle(s) stop for more than a set number of minutes 
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Unauthorized Movement Alert 
Sends an alert if the selected vehicle(s) record movement without the ignition being on 
 

Viewing Alert History 

1. The Alert History loads automatically when the Alerts tab is selected 
2. This tab shows all alerts generated by all vehicles on the account, along with the Date/Time, 

Alert Type, Vehicle, Name, Location and Details 
 

 
 

Filtering the Alert History 

4. At the top left of the tab, click the Filters dropdown 
 

 
 

5. Select your desired filters from the available options 
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6. Click Filter. The History tab will update with the filtered data 

 

 
 

Clearing Filters from the Alert History 

1. To clear your selected filters, click the Clear Filtering button ( ) to the right of the filter 
selection 

 

 
 

2. The History tab will refresh with no filters 
 

Creating an Alert 

1. Select an Alert Type from the left side 
 

  
 

2. Click Add New to open the Add Alert window  
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3. Enter a Name for the alert 
4. Select a Vehicle Group(s) and/or Vehicle(s) for the alert to be assigned to 
5. Other information may be required, depending on the type of alert (e.g. Distance, Idle time, 

etc.) 
6. Use the Add Recipient field to add emails or mobile numbers. Whenever this alert is triggered, 

these recipients will be notified 
7. Add Comments, if necessary 

 

 
 

8. Click Save 
 

Editing an Alert 

1. Click the Saved Alerts tab to open the list of saved alerts 
2. Double click the alert to be edited 

 

 
 

3. This opens the Edit Alert window 
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4. All fields can be edited, but the fields marked with a * must contain valid information 
5. Click Save 
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Reports Tab 
 

These actions are available under the Reports tab 
 

 
 

Types of Reports 

Alerts 
Shows the total alerts sent to the selected vehicle(s), the most frequent alert sent, the time sent and 
the location the alert was generated. If multiple vehicles are selected, this report will also show the 
vehicle with the greatest number of alerts 
 
Daily Details 
Shows the stop time, move time, run time, idle time, total distance, number of stops, landmarks and 
inputs for each vehicle during the selected day. If a vehicle’s information is expanded, this report will 
show the total values for previous days as well 
 
Idle 
Shows the amount of time a vehicle has been idling (ignition on without movement). When a group is 
expanded, specific information for each vehicle is displayed 
 
Inactivity 
Shows total inactivity time, total inactive vehicles, most inactive vehicle, average inactive time per 
group and average inactive time per vehicle. User specifies inactivity duration they would like reported. 
Each vehicle’s group, inactivity start time, last driver, current location and inactivity duration are also 
shown 
 
Inputs 
Shows all of the Input Alerts for each vehicle during the specified reporting period. Input parameters 
are user-defined 
 
Landmark Circulation 
Shows the total visits, average visits per day, total duration of visits and average duration of visits for 
all selected landmarks. When expanded, specific data for each landmark is shown 
 
Location History 
Shows all events for each vehicle during the specified reporting period. Includes total number of 
events, total landmarks visited, distance traveled, average speed, highest speed for all vehicles. Each 
specific vehicle also shows date/time, type of event, drive, location, latitude, longitude, heading and 
speed 
 
Maintenance 
Shows all scheduled maintenance alerts by maintenance type and vehicle 
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State Mileage 
Shows the distance traveled in each state by any vehicle during the specified reporting period 
 
Stops 
Shows all of the stops that occurred for the vehicle(s) during the specified reporting period. When a 
group’s information is expanded, specific vehicle data is shown. When a vehicle’s information is 
expanded, specific data for each stop is shown 
 
Trips – Consolidated 
Shows a summary of all trips over a certain distance for each vehicle during the reporting period. 
Includes ignition on/off, move time, time ignition was on, idle time, distance, max speed and start/end 
address. In order for this report to work, the ignition wire must be connected 
 
Workday Details Report 
Shows start and end times, start and end addresses, elapsed time, move time, engine off time, idle time 
and off duty time for each vehicle on each day during the specified reporting period 
 

Filtering the Report History 

1. At the top left of the tab, click the Filters dropdown 
 

 
 

2. Select your desired filters from the available options 
 

 
 

3. Click Filter. The History tab will update with the filtered data 
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Clearing Filters from the Report History 

1. To clear your selected filters, click the Clear Filtering button ( ) to the right of the filter 
selection 

 

 
 

2. The History tab will refresh with no filters 
 

Generating a Report 

1. Select a Report Type from the left side 
 

  
 

2. Click Generate Report to open the New Report window 
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3. In the New Report window, specify all required information (e.g. Vehicle Group(s), 

Vehicle(s), Start Date, End Date, Daily Start Time and Daily End Time) 
4. If applicable, select other options (e.g. types of alerts, length of Idle events, length of Inactivity, 

Landmark Group, etc) 
 

 
 

5. Click Generate Report 
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Scheduling a Report 

1. In the New Report window, click the Schedule, Save & Send tab 
2. Click the check box next to Schedule Delivery 
3. Use the Schedule Delivery dropdown to select a frequency for the report to be run 
4. Use the Report Format dropdown to choose a file format for the report 

 

 
 

5. Click Save Report or Save & Generate Report 
 

Saving a Report 

1. In the Schedule, Save & Send tab, click the check box next to Save Configuration 
2. Enter a name for the selected report parameters 
3. Click Save Report 
4. This report can now be run at any time by selecting the type of report from the left side, then 

choosing from the Saved reports list 
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Sending a Report 

1. In the New Report window, click the Schedule, Save & Send tab 
2. In the Add Recipient field, enter the recipient email address(es) 

 

 
 

3. Click Generate Report 
 

Creating a Landmark from a Report Map 

1. Click a Location link in any applicable report 
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2. When the event’s location data is displayed, click the  icon in the center of the map, then 
click Add Landmark to open the Add Landmark window 

 

 
 

3. Fill out the Add Landmark window and click Save 
 

Deleting a Report 

1. Click the Edit icon () next to the report you would like to delete 
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2. In the Edit Report window, click the Delete button 
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Admin Tab 
 

These actions are available under the Admin tab 
 

 
 

 
 

Devices 

1. Select Devices from the left side 
2. The Devices list shows all devices on the account 
3. The Association dropdown in the upper right corner allows the list to filtered by device Linked 

to a vehicle and devices that are Unlinked 
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Creating a Vehicle 

1. Select Vehicles from the left side 
2. Click Add 

 

 
 

3. This opens the Add Vehicle window 
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4. Fill out the required fields, marked with a * 
5. Fill out the remaining fields and assign the vehicle to a Group (optional) 

a. Note: If a vehicle is not paired with a device, it will not appear on the map 
6. Assign Inputs to the vehicle (optional) 

 

 
 

7. Click Save 
 

Editing a Vehicle 

1. Select Vehicles from the left side 
2. Double-click the vehicle to be edited, or click the checkbox next to the vehicle to be edited and 

click Edit 
 

 
 

3. This opens the Edit Vehicle window 
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4. From this window, all elements of the vehicle can be edited 

 

 
 

5. Click Save 
6. Click Delete to permanently remove a vehicle from your account 
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Bulk Editing Vehicles 

1. Select Vehicles from the left side 
2. Click the checkboxes next to all vehicles to be edited, then click Edit 

 

 
 

3. This opens the Bulk Edit Assets window 
4. From this window, Group, Asset Type, Year, Make, Model and Initial Odometer can be 

changed for all selected vehicles 
 

 
 

5. Click Save 
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Unlinking a Vehicle from a Device 

1. Devices can be disassociated from their assigned vehicle. 
2. Once a device and vehicle are disassociated, a new device and/or vehicle can be assigned 
3. Under Vehicles on the left side, select a vehicle from the list 
4. Click Edit to open the Edit Vehicle window 

 

 
 

5. Click Clear to disassociate the Device Serial from the selected vehicle 
6. Click Save 

 
Creating a Vehicle Group 

1. Select Vehicle Groups from the left side 
2. Click Add Group 

 

 
 

3. This opens the Add Vehicle Group window 
4. Name the new Vehicle Group 
5. Use the checkboxes to select all vehicles to be put in the new group 
6. Click the right-facing arrow to move the selected vehicles into the new group 
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7. Click Save 
 

Adding a Driver 

1. Select Drivers from the left side 
2. Click Add 

 

 
 

3. This opens the Add Driver window 
4. Fill out the required fields, marked with a * 
5. Fill out the remaining fields (optional) 
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6. Click Save 
7. Click Clear to reset the form and start again 

 
Editing a Driver 

1. Select Drivers from the left side 
2. Double-click the driver to be edited, or click the driver to be edited and click Edit 

 

 
 

3. This opens the Edit Driver window 
4. From this window, all elements of the driver can be edited 

 

 
 

5. Click Save 
6. Click Delete to permanently remove the driver from the system 
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Creating a Landmark from the Admin Tab 

1. Select Landmarks from the left side 
2. Click Add 

 

 
 

3. This opens the Add Landmark window 
4. Fill out the required fields, marked with a * 

a. The Latitude and Longitude fields will default to the center of the map on the Landmarks 
page 

b. If the address fields are filled out, the Latitude and Longitude fields will automatically 
populate 

5. Fill out the remaining fields and assign the landmark to a Group (optional) 
a. The fields above the map allows you to choose the landmark’s Shape, Radius, Line 

Color, Fill Color, Transparency and Line Width 
i. A Line Width of 0 will hide the landmark’s borders 

 

 
 

6. Click Save  
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Editing a Landmark 

1. Select Landmarks from the left side 
2. Double-click the landmark to be edited, or click the checkbox next to the landmark to be edited 

and click Edit 
 

 
 

3. This opens the Edit Landmark window 
4. From this window, all elements of the landmark can be edited 

 

 
 

5. Click Save 
6. Click Delete to permanently remove the landmark from the system 
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Importing Landmarks 

1. Select Landmarks from the left side 
2. Click Import 

 

 
 

3. This opens the Import Landmarks window 
4. Select a CSV Format 
5. Follow the formatting guidelines displayed in the window 
6. Select the CSV file using the Select button under step 2 

 

 
 

7. Click Import 
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Exporting Landmarks 

1. Select Landmarks from the left side 
a. If no landmarks are selected, all landmarks will be exported 

2. Click Export 
3. This will automatically export a CSV of all the landmarks currently displayed 

a. If the checkboxes have been used to select multiple landmarks, only those landmarks will 
be exported 

 

 
 

Bulk Editing Landmarks 

1. Select Landmarks from the left side 
2. Click the checkboxes next to all landmarks to be edited, then click Edit 

 

 
 

3. This opens the Bulk Edit Landmarks window 
4. From this window, Group, Shape and Radius can be changed for all selected landmarks 

 

 
 

5. Click Save 
 

Creating a Landmark Group 
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1. Select Landmark Groups from the left side 
2. Click Add Group 

 

 
 

3. This opens the Add Landmark Group window 
4. Name the new Landmark Group 
5. Use the checkboxes to select all landmarks to be put in the new group 
6. Click the right-facing arrow to move the selected landmarks into the new group 

 

 
 

7. Click Save 
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Creating a User 

1. Select Users from the left side 
2. Click Add 

 

 
 

3. This opens the Add User window 
4. Fill out the required fields, marked with a * 
5. Fill out the remaining fields and assign a User Access and User Role 

 

 
 

6. Click Save 
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Editing a User 

1. Select Users from the left side 
2. Double-click the user to be edited, or click the checkbox next to the user to be edited and click 

Edit 
 

 
 

3. This opens the Edit User window 
4. All fields can be edited, but the fields marked with a * must contain valid information 

 

 
 

5. Click Save 
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Bulk Editing Users 

1. Select Users from the left side 
2. Click the checkboxes next to all users to be edited, then click Edit 

 

 
 

3. This opens the Bulk Edit Users window 
4. From this window, User Access and User Role can be changed for all selected users 

 

 
 

5. Click Save 
 

Adding a User Access 

A User Access determines which vehicles and/or landmarks a user has access to 
 
1. Select User Access from the left side 
2. Click Add 
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3. This opens the Add User Access window 
4. Choose a name for the new User Access 
5. The Vehicles tab lists all vehicles available and can be searched or filtered by group 
6. Use the checkboxes to select any vehicles to be included 
7. Click the right-facing arrow to add those vehicles 
8. The Landmarks tab lists all landmarks available and can be searched or filtered by group 
9. Use the checkboxes to select any landmarks to be included 
10. Click the right-facing arrow to add those landmarks 

 

 
 

11. Click Save 
12. The new User Access will now display in the list and can be assigned to users 

 
Editing a User Access 

1. Select User Access from the left side 
2. Double-click the access to be edited, or click the checkbox next to one of the accesses listed, 

then click Edit 
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3. This opens the Edit User Access window 
4. From this window, all elements of the selected User Access can be edited 

 

 
 

5. Click Save 
 

Adding a User Role 

A User Role determines what a user can view and/or modify with the vehicles and landmarks they 
have access to 

 
1. Select User Roles from the left side 
2. Click Add 

 

 
 

3. This opens the Add User Role window 
4. Enter a Name for the User Role 
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5. Select a role in the Start From dropdown, or leave the dropdown at [Custom] to create a role 

from scratch 
a. Manager – can Modify the Map, Alerts and Reports sections 
b. Dispatcher – can Modify the Map and Alerts sections 
c. Administrator – can Modify all sections 

6. Default roles cannot be edited 
7. If you create a role from scratch, there are the following options for the Map, Alerts, Reports 

and Admin sections: 
a. None – the user will not see the section when they log in, they cannot view or modify any 

information within that section 
b. View – allows the user to view the selected section, but they cannot modify any data 
c. Modify – allows the user to view and modify data within the selected section 

 

 
 

8. Click Save 
 

Editing a User Role 

1. Select User Roles from the left side 
2. Double-click the User Role to be edited, or Click the User Role to be edited, then click Edit 
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3. This opens the Edit User Role window 
4. From this window, all elements of the selected User Role can be edited 

 

 
 

5. Click Save 
 

Removing a Recipient 

1. Select Recipients from the left, then enter the email address or mobile number of the recipient 
you wish to remove 

 

 
 

2. Use the Delete icon ( ) to remove the email address or mobile number from the recipient list 
of any listed alerts or reports 
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Messaging Tab 
 

A Messaging tab has been added to user accounts that have Messaging-enabled vehicles. This new 
tab allows you to send jobs to a user’s Garmin device. 
 

 
 

Changing the Map View 

1. Use the Start/Stop Dates option at the top of the Jobs Log and Messages Log to specify a 
date range. Only messaging data from the selected date range will display on the map and in 
the Jobs and Messages Log 

 

 
 

2. Click Apply 
3. Select the View dropdown from the upper left corner of the map 

 

 
 

2. Use the checkboxes to select the level of detail displayed on the map 
a. Show Vehicles – shows vehicles on the map 
b. Show Landmarks – shows landmarks on the map 
c. Show Traffic – shows current traffic information, which may not match conditions at the 

time a route was taken 
d. Show Terrain – shows terrain information 
e. Show Weather – shows current weather information, which may not match conditions at 

the time a route was taken 
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f. Use Clustering – displays vehicles in small groups that will separate when a user zooms in 
g. Show Vehicle Labels – shows vehicle label information on the map 
h. Show Landmark Labels – shows landmark label information on the map 

4. The job icon legend is at the top right of the map. Hovering over an icon will show text 
specifying which job status that icon represents 

 

 
 

Jobs & Messaging Control Panel 

1. The Jobs & Messaging control panel is located to the left of the map and displays all jobs 
scheduled during the selected date range 

2. Under the Map Label column, the circle icon indicates whether the Garmin device is powered 
on (green) or off (red) 

 

 
 

3. Double-clicking a vehicle will open that vehicle’s job history. By default, only jobs within the 
Start/Stop Dates will display, but you can choose to display all jobs for the selected vehicle 

4. Selecting a job from the history will re-center the map to that job’s location 
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Adding a Job 

1. In the Jobs & Messaging control panel on the left side, click the  in the upper right to open 
the Add Job window 

 

 
 

2. Fill out the required fields, marked with a * 
a. Use the checkbox above the map to schedule the job to be sent at a later date and time 

i. Note: The selected delivery date must be before the selected start date 
3. Click Save + Add New to save this job and add another, or click Save to save the current job 
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Sending a Message 

1. In the Jobs & Messaging control panel on the left side, click the Create a new message icon 
( ) next to the vehicle you need to send a message to 

2. This will open a window containing all messages sent to or received from the selected vehicle 
 

 
 

a. This window can be modified to display messages from the past 1 Day, 1 Week, 2 Weeks, 
or 1 Month 

3. Use the text field at the bottom of the window to send new text messages to the selected 
vehicle 
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Jobs Log 

1.  The Jobs Log is located below the map and displays all jobs scheduled during the selected 
date range (as defined by the Start/Stop Dates option at the top right of the map) 

 

 
 

2. Selecting a job from the Jobs Log will re-center the map on that job’s location and display job 
details 

 

 
 

Editing or Deleting Jobs 

1. Jobs can be edited or deleted using the Delete job ( ) and Edit job ( ) buttons to the left of 
each job 

2. Click the Edit job button will open the Edit Job window 
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a. From this window, all fields of the job can be edited 
i. Note: The Start Date cannot occur before the current date 

b. Click Save 
 

Importing Jobs 

1. Click Import in the upper right of the Jobs Log to open the Import Jobs window 
 

 
 

2. Select a CSV Format 
3. Follow the formatting guidelines displayed in the window 
4. Select a CSV file using the Select button under step 2 

 

 
 

5. Click Import 
 

Exporting Jobs 

1. Click Export in the upper right of the Jobs Log 
 

 
 

2. This will automatically export all jobs currently displayed in the Jobs Log as a CSV file 
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Messages Log 

1. The Messages Log is located below the map and displays all messages sent to vehicles 
during the selected date range (as defined by the Start/Stop Dates option at the top right of 
the map) 

 

 
 

Viewing Message History and Sending Messages 

1. Double-clicking a message from the Messages Log will open a window containing all 
messages sent to or received from the selected vehicle 

 

 
 

2. This window can be modified to display messages from the past 1 Day, 1 Week, 2 Weeks, or 1 
Month 
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3. Use the text field at the bottom of the window to send new text messages to the selected 

vehicle 
 

 
 

Exporting Messages 

1. Click Export in the upper right of the Messages Log 
 

 
 

2. This will automatically export all messages currently displayed in the Messages Log as a CSV 
file 
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